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This software was developed by the Centers for Medicare & Medicaid Services (CMS) for use by Medicare providers/suppliers to 
view and print a Health Insurance Portability and Accountability Act (HIPAA) compliant Medicare 835. Medicare has no liability and 
takes no responsibility for any other use of this software. 
 
This material contains confidential, proprietary information of ViPS, a General Dynamics IT Company. Use or disclosure of the 
information contained in this material (or any part thereof), without the express written consent of ViPS, a General Dynamics IT 
Company, is strictly prohibited. No part of this material may be used, reproduced, modified, distributed, transmitted, or disclosed (in 
any form or by any means, including electronically or otherwise), except as otherwise specifically permitted by the end-user software 
license applicable to this material. Any software made available to you (“Software”) is the property of ViPS, a General Dynamics IT 
Company, and/or its suppliers and is protected by U.S. and international copyright laws. Use of the Software is governed by the 
terms of the end-user license agreement, which accompanies or is included with the Software (“License Agreement”). Any other 
use, including the reproduction, modification, distribution, transmission, or display of the Software is strictly prohibited, and may 
result in criminal and civil penalties. The Software is warranted, if at all, in accordance with the terms of the License Agreement. 
Except as warranted in the License Agreement, ViPS, a General Dynamics IT Company, hereby disclaims all warranties and 
conditions with regard to the Software, including, but not limited to, implied warranties of merchantability and fitness for a particular 
purpose. 
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About Medicare Remit Easy Print 
Medicare Remit Easy Print enables you to print Medicare Part B and DME MAC HIPAA 
835v5010 and 835v4010A1 files to a format that is similar to the Standard Paper 
Remittances (SPRs).You can use Medicare Remit Easy Print to: 

• view MREP Remittance Advices (see page 56) 

• search MREP Remittance Advices (see page 81) 

• print MREP Remittance Advices (see page 78) 

• print reports about MREP Remittance Advices (see page 204). 

You can install Medicare Remit Easy Print on a PC or on a network (see Pre-Installation 
Checklist for Installation on a PC). 

  
For general information about remittances, see 
http://www.cms.hhs.gov/MLNProducts/downloads/RA_Guide_Full_03-22-06.pdf . 

http://www.cms.hhs.gov/MLNProducts/downloads/RA_Guide_Full_03-22-06.pdf
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What’s New 
• Under CR7499, the FCN/OTHER IDENTIFIER field of the PLB adjustment details increased from 30 

bytes to 50 bytes. To accommodate this change, the field labels of the PLB details on the PROVIDER 
PAYMENT SUMMARY REPORT were replaced by column headings that mirror those of the 
ENTIRE REMITTANCE REPORT. The spacing of the PLB details on both reports has been adjusted.  

Note: The PLB headings only appear when PLB data is present. 

Informational 
• MREP accepts remittances in the X12 835V5010A1 and X12 835V4010A1 formats. MREP no longer 

accepts remittances in the X12 835V5010 format. However, since the X12 835V5010 format was only 
used during the transition period from X12 835V40101A1 and was never implemented for use in 
production, the User Guide refers to the X12 835V5010A1 format as X12 835V5010. 

   
• MREP Version 3.3 includes the CARC/RARC list published 7/1/2012. Future lists will be made 

available individually and can be imported into MREP to keep the codes current. For more 
information, see How to View the CARC and RARC Codes.  
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Differences between MREP Remittance Advices and Shared 
System SPRs 
It is important to understand that the Medicare Remit Easy Print Remittance Advice is a representation of the 
HIPAA 835v4010A1 transaction data. Although CMS has attempted to make the Medicare Remit Easy Print 
generated Remittance Advice very similar to the Shared System Maintainer generated SPR (received via mail), 
the printed information and data content at times may differ. So, the two can be compared as long as there is an 
understanding of why they differ. 

For example, the HIPAA 835v5010 transaction data contains reversal (mother) claim information and, in turn, 
the Medicare Remit Easy Print Remittance Advice displays this information and uses it in the calculation of 
the entire remittance “totals”. The CMS systems that create the file for the SPR received via mail have the 
ability to “net” the claim information for adjustments prior to generating the SPR. The HIPAA 5010 
transaction has no facility to convey the information to allow MREP to “net” the claim information for 
adjustments prior to generating the Medicare Remit Easy Print Remittance Advice and, therefore, must do a 
complete back-out of the original claim and “build” a new “adjusted” claim with the modified information. 

Item Medicare Remit Easy Print Shared System 

Adjustments 

You must calculate the net. 
 
Claim Example #1   
Original Claim          000000000001000   
Provider Paid         -$100.00 
Adjustment Claim    000000000001001  
Provider Paid          $80.00 
Provider Paid         -$20.00 (overpayment) 
 
Claim Example #2       
Original Claim         000000000002000  
Provider Paid          -$100.00 
Adjustment Claim    000000000002001  
Provider Paid     $150.00 
Provider Paid           $50.00 (underpayment) 

The net was calculated for you. 
 
Claim Example #1           
Adjustment Claim    000000000001001 
Provider Paid          -$20.00 
 
Claim Example #2           
Adjustment Claim   000000000002001            
Provider Paid          $50.00 

PREV PD 
Always blank 
 

Is calculated for you 

General Messages 
for Suppliers/ 
Providers (Provider 
Bulletin Board) 

Not displayed Is displayed 
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About This Guide 
All personal health information has been replaced with fictitious information.  

To use this guide, you need to have a working knowledge of Microsoft Windows.  

For example, you need to know how to: 

• access your desktop, 

• use the Start menu, and 

• use Microsoft Windows Explorer. 

You also need to know common Microsoft Windows terminology. For example, Start > 
Programs refers to the Programs option on the Start menu. 

Need Assistance? 
If you need assistance, please contact: 

Email Your Medicare contractor 

Phone Your Medicare contractor 

PC Requirements  
Recommended 
Speed: 

 
2.0 GHz or faster 
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Operating System Requirements 
Recommended: Windows XP 

Others: Windows 2000 
Windows NT 
Windows 7 
Windows Vista 

.NET Framework:  
       
 

1.1.4322 (On the Microsoft web site this is referenced as 1.1) 
This application uses Visual Basic.Net, a Microsoft compatible language, and 
like many applications that require a MS Windows platform, a .NET framework 
is required. More than likely you already have a version of the .NET framework 
on your PC. In order to use this application, you must have .NET framework 
version 1.1.4322 or a later version installed on each PC that is using this 
application. If you do not have this framework installed, you may receive a 
message stating that this version of the framework is required during the 
installation process and prompting you to install it. 

 
By clicking yes—and if you have access to the internet—you are redirected to 
the Microsoft web site to download the .NET framework 1.1 (same as the 
1.1.4322 version referenced in the message). It is not recommended that you 
download a beta version of the .NET framework if you are presented with this 
option on the Microsoft web site.  

Outside of the application installation process, you may also visit the link to 
Microsoft .NET Framework Version 1.1 Redistributable Package at the 
Microsoft website to transport directly to the location on the Microsoft web site 
to download the 1.1 .NET framework version. 

If you want to learn more about the 1.1 .NET Framework version and/or 
determine if you need to install this version, you may visit  
.Net Framework Developer Center at the Microsoft website. 
Please follow the directions within the web site when using this link. 
If you do not have access to the internet and you receive a message to update 
your .NET framework, you have to obtain a copy of the .NET framework from 
Microsoft. The Medicare Remit Easy Print application does not work without 
the appropriate .NET framework installed on each machine accessing the 
application. 
 

http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=26
http://msdn.microsoft.com/en-us/netframework/default.aspx
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Decompression 
Application: 

To download the Medicare Remit Easy Print program from your Medicare 
contractor’s web site, you must have the following: 

• Access to the internet. 

• WinZip or a compatible decompression application to extract files. If you do 
not have a decompression application then you can go to a number of web 
sites to acquire one (For example: http://www.winzip.com/downwzeval.htm.) 
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How Does Medicare Remit Easy Print Get Medicare 
Remittance Info? 

You have to import Medicare remittance information into Medicare Remit Easy Print. For 
more information about importing, see Importing HIPAA 835 files. 

 The files that you import are the ANSI files. For more information about the format of these 
files, see Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk. 

 When Medicare Remit Easy Print reformats and saves a copy of an HIPAA 835 file, it is 
called the Import file. For information about how EasyPrint names the Import files, see Import 
File Name Format.  

Medicare Remit Easy Print keeps all of the Import files in the Import folder in the Medicare 
Remit EasyPrint directory. 
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Information for Administrators 
Medicare Remit Easy Print can be installed on a PC or network.  
 
To install MREP: 

• on a PC, see PC Installations    
• on a network, see Installing Medicare Remit Easy Print on a Network 

 

Network Installations  
Medicare Remit Easy Print Directory 

There must be sufficient space on the network to save the Import file(s). 

The Medicare Remit Easy Print software takes about 3000 KB. 

Users must have Read/Write access to the directory where the software is installed because the 
software creates files and saves them using the user’s security privileges to the directory. 

Medicare Remit Easy Print Access 

If you need to make Medicare Remit Easy Print available to all users who log on, you need to 
indicate this during the installation procedure. 

Group Code MSI file 

When installing the application on a network, each PC that accesses the application must have 
installed the Group Code MSI file. 
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Pre-Installation Checklist for Installation on a Network 
Before you install Medicare Remit Easy Print, you need to complete these steps: 

Step Description Completed 
 

1 Check that the network, all PCs, and printers meet all requirements.  

2 Check that you are using one of the supported operating systems.  

3 Find out where the Medicare Remit Easy Print installation software is located.  
The file name is: Medicare Remit Easy Print.msi 

Write the location here: 
 

 

4 Find out where the Medicare Remit Easy Print Group Code .msi file is: 
The file name is: GroupCode.msi 

Write the location here: 
Note: The GroupCode.msi must be installed on all PCs executing EasyPrint 

from a network location or any PCs that access network locations 
from within the application. 

 When installed on a network drive, only the EasyPrint shortcut and 
the GroupCode.msi package need to be installed on PCs executing 
the application. There is no need to install the application on each 
individual PC.  
In order for each client PC to access the application: From the client 
PC, navigate to the network location where Medicare Remit Easy 
Print is installed, right click on the EasyPrint.exe file, and select 
“create shortcut”. This shortcut can then be copied to the desktop of 
the client PC. This step is necessary in the event the network drive 
mapping is different on the client PC. 

 

5 Create a folder called HIPAA 835 files and make sure that all users know the 
location.  
This folder must have adequate security for PHI. 
Write the location for the HIPAA 835 files here: 

 

6 Create a directory on the server for the Medicare Remit Easy Print 
installation.  
This directory must have adequate security for PHI. 
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Installing Medicare Remit Easy Print on a Network 
When you install Medicare Remit Easy Print on a network: 

• install Medicare Remit Easy Print on the network 

• install the Medicare Remit Easy Print Group Code on every PC accessing the 
application. 

Before You Install Medicare Remit Easy Print on a Network 
Before you install Medicare Remit Easy Print: 

• complete the Pre-Installation Checklist for installation on a network. 

How to Install Medicare Remit Easy Print on the Network 
Download Instructions 

On your contractor’s website: 

1. Select the Medicare Remit Easy Print link. 

2. Click the Medicare Remit Easy Print zip file. The File Download window opens. 

  
3. Click the Open button. The WinZip window opens. 

Important! 
If this download 
cannot get past 
your network 
firewall, please 
contact your 
Medicare 
contractor. 
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4. To extract the file to the network, highlight GroupCode.msi and click the Extract button. 

The Extract window opens. 

  
5. Select the directory on your network where you want the GroupCode.msi file to be stored. 

Click the Extract button. You return to the WinZip window. 

6. On the following line, write the name of the folder where you saved the GroupCode.msi 
file:  

 ___________________________________________________________ 

7.  Highlight the MedicareRemitEasyPrint.msi file and click Extract. 

8.  Select the same location on your network where you saved the GroupCode.msi file. Click 
the Extract button. 
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Installation Instructions 

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 3 of the 
Pre-Installation Checklist for Installation on a PC. 

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file. 

3. Double-click the Medicare Remit Easy Print.msi file: 

 
The Medicare Remit Easy Print Setup Wizard opens. 

 
4. Click the Next button. 



Medicare Remit Easy Print PC Installations 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

18 

The Select Installation Folder window opens.  

 

 

 

 

 

 

 

 

 

 

 

 

5. Click Browse to find the network location for the install. The applications and associated 
files are located in the T:\Easy Print Files\ folder.  

6. On the following line, write the location where you are saving the application and where 
all of the associated folders and files are to be saved: 

________________________________________________________ 

Select Everyone and click the Next button. 

The Confirm Installation window opens. 

7. Click the Next button. 

T:\Easy Print Files\ 
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When the installation is finished, the Installation Complete window opens. 

8. Click the Close button. 

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy Print 
directory. Copy this shortcut to your desktop. 

9. Complete the Medicare Remit Easy Print Group Code installation on each PC. 

What Happens During the Installation Process? 

The following items are created and placed in the directory you designated under the Medicare 
Remit Easy Print folder in Step 8 of the Installation Instructions: 

• EasyPrint.exe 

• Easy Print icon - shortcut 

• Import folder - where all active converted HIPAA 835 files are stored 

• Archive folder - where all inactive converted HIPAA 835 files are stored. (Inactive 
files are files not currently viewed in the application.) 

• Report Export folder - where all exported Report files are stored 

• Resource folder - internal folder to application 

 

Best Practice: 
Make the shortcut 
to the Medicare 
Remit Easy Print 
executable 
available to all 
users. 

Important! 
You must install 
the Medicare 
Remit Easy Print 
Group Code on 
each PC. 
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 Installing the Medicare Remit Easy Print Group Code on the PC 
After you install the Medicare Remit Easy Print application on the network, you must install 
the GroupCode.msi file on every PC that needs to access the application. 

How to Install the Medicare Remit Easy Print Group Code  
1. Make sure you know the location of the Medicare Remit Easy Print Group Code file (Step 

4 of the Pre-Installation Checklist for Installation on a PC. 

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print Group 
Code.msi file. 

3. Double-click the Medicare Remit Easy Print Group Code.msi file. 

  
The installation completes without opening any windows or displaying any messages. 

How to Know that the Medicare Remit Easy Print Group Code Install 
Completed Successfully 

If the installation DID complete successfully, the PC user can open Medicare Remit Easy 
Print. 

If the installation DID NOT complete successfully, the PC user cannot open Medicare Remit 
Easy Print is presented with an unhandled exception dialog. 

 
Click OK and install the Medicare Remit Easy Print Group Code again. 

Hint: 
If you see this error 
message on the PC, 
you need to install 
the Medicare Remit 
Easy Print Group 
Code. 
You need a minimum 
screen resolution of 
1024 X 768. 
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PC Installations 
Medicare Remit Easy Print Setup Software 

For users to load the software on their PCs, they must know the location of the Medicare 
Remit Easy Print Setup file. 

The file name is:  

 Medicare Remit Easy Print.msi  

HIPAA 835 File Location 

Users must know the location from which to download the HIPAA 835 file they receive from 
their Medicare contractor. 

Medicare Remit Easy Print Directory 

There must be sufficient space on the PC for Medicare Remit Easy Print to save the Import 
file(s).  

The Medicare Remit Easy Print software takes about 3000 KB. The size of the Import file(s) is 
dependent upon the number of claims found in the HIPAA 835 file. 

Medicare Remit Easy Print Access 

The default for installing Medicare Remit Easy Print is to have it be accessible only to a single 
user on a PC. 

Getting Started 
To get started: 

1. Complete the Pre-Installation Checklist for Installation on a PC. 
 

2. Install Medicare Remit Easy Print on your PC (see page 19). 

Best Practice: 
Create a folder 
called HIPAA 
835 files to 
store your 835 
files, and make 
sure that all 
users know the 
location. 
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Pre-Installation Checklist for Installation on a PC 
Before you install Medicare Remit Easy Print, you need to complete these steps: 

Step Description Completed 
 

1 Check to be sure that your PC and printer meet all requirements.  

2 Check to be sure that you are using one of the supported operating systems.  

3 
Find out where the Medicare Remit Easy Print install file is located.  
The file name is: Medicare Remit Easy Print.msi 
Write the location here: 

 

4 Find out where the HIPAA 835 files are located. 
Write the location here: __________________________________________ 
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Installing Medicare Remit Easy Print 

Before You Install Medicare Remit Easy Print 
Before you install Medicare Remit Easy Print: 

• Complete the Pre-Installation Checklist for Installation on a PC 
. 

How to Install Medicare Remit Easy Print on Your PC 
Download Instructions 

On your contractor’s website: 

1. Select the Medicare Remit Easy Print link. 

2. Click the Medicare Remit Easy Print zip file.  

The File Download window opens. 

  
3. Click the Open button.  

Important! 
If this download 
cannot get past 
your PC security 
settings, please 
contact your 
Medicare carrier. 
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The WinZip window opens. 

  
4. To extract the file to the network, highlight MedicareRemitEasyPrint.msi and click the 

Extract button. The Extract window opens. 

  
5. Select the directory on your network where you want the MedicareRemitEasyPrint.msi file 

to be stored.  

6. Click the Extract button. You return to the WinZip window. 

7. On the following line, write the name of the folder where you saved the 
MedicareRemitEasyPrint.msi file: 

 ___________________________________________________________ 

Because you are not installing the software on a network to be shared by other users, you 
do not need to copy the GroupCode.msi file. 

Best Practice: 
Create a folder 
called HIPAA 
835 files to 
store your 835 
files, and make 
sure that all 
users know the 
location. 
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Installation Instructions 

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 3 of the 
Pre-Installation Checklist for Installation on a PC. 

 

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file. 

3. Double-click the Medicare Remit Easy Print.msi file: 

 
The Medicare Remit Easy Print Setup Wizard opens. 

 
4. Click the Next button. 
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The Select Installation Folder window opens.  

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Click Browse to find the location of the Easy Print files on your PC. This is where the 
application and all the associated files are stored. 

12.  On the following line, write the location where you are saving the application and where 
all of the associated folders and files are to be saved: 

13. Select Everyone and click the Next button. 

The Confirm Installation window opens. 

14. Click the Next button. 

T:\Easy Print Files\ 
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When the installation is finished, the Installation Complete window opens. 

15. Click the Close button. 

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy Print 
directory. Copy this shortcut to your desktop. 

 What Happens During the Installation Process? 

The following items are created and placed in the directory you designated under the Medicare 
Remit Easy Print folder in Step 8 of the Installation Instructions: 

• EasyPrint.exe 

• Easy Print icon (shortcut) 

• Import folder (where all active converted x835 files are stored) 

• Archive folder (where all inactive converted x835 files are stored. Inactive files are 
files not currently viewed in the application) 

• Report Export folder (where all exported Report files are stored) 

• Resource folder (internal folder to application) 
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Hint: 
You can find 
the Medicare 
Remit Easy 
Print shortcut 

 on the 
desktop and on 
the Start 
menu. 

Starting Medicare Remit Easy Print 
You can find shortcuts to the Medicare Remit Easy Print program in 2 places: 

• Your PC desktop:   

• The Start > Programs menu:   

Before You Start Medicare Remit Easy Print 
Before you start Medicare Remit Easy Print, you must: 

• Install Medicare Remit Easy Print (page 19). 

• To determine the location of the HIPAA 835 folder or where your HIPAA 835 files 
are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC. 

  

How to Start Medicare Remit Easy Print 
1. To start Medicare Remit Easy Print, double-click the Medicare Remit Easy Print shortcut. 

The first time that you start Medicare Remit Easy Print, or when you don’t have any 
Remittance files in the Import folder you see the “No Remittance Files Found” dialog. 
Click or select the OK button to close the dialog. 

 
Click the OK button. 
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Medicare Remit Easy Print opens with the Import button ready: 

 
2. Click the Import button. 
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A file dialog window opens permitting you to select the HIPAA 835 file to import. 

 
3. Select the HIPAA 835 file that you want to import by double-clicking it. 

Medicare Remit Easy Print starts the import to let you know that it is importing: 
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Hint: 
Click on a 
column 
heading to 
change the 
sort order. 

After the import is finished, the Remittance Advice List window appears. 

 
 

 

Menus 
Toolbar 

List of 
Remittance 

Advices 

Claim List 
tab is active 

List of claims 
for the 

highlighted 
Remittance 

 

Total 
provider 

paid 
amount 
for the 
claim 

Earliest 
From 

Date of 
service 
on the 
claim 

Latest 
To Date 

of 
service 
on the 
claim 

Internal 
account 

number(s) 

Total 
billed 

amount 
for the 
claim 

Internal 
control 

number(s) 
(Claim 

Number) 

 
Bene 

name(s) 
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Locating MREP and MREP File Locations on Your PC/Network 

Locating the MREP Application on Your PC/Network – Icon 
Available 

1. With your mouse, right click on the icon on your desktop. 
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2. Go to Properties, Shortcut, Start in and you see the directory where the Medicare Remit 
Easy Print directory is located. 
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Locating the MREP Application on Your PC/Network – Icon not 
Available 

1. Click the Start menu. 

2. Select the ‘Search’ function. 

3. Select ‘For Files or Folders’. 
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4. Select ‘All files and folders’. 
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5. Type ‘Medicare Remit Easy Print’ or the name you saved your MREP software under in 
‘All files and folders’. 

6. Select ‘My Computer’ from the ‘Look In’ drop-down box. 

 

7. Click the Search button. 
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Identifying Easy Print File Locations 
This tool contains the current path to folders containing the files that Medicare Remit Easy Print 
uses. In most cases, these paths never need updating. But, in certain situations, the user may want 
to override the default locations of these folders. 

1. To identify the necessary files/resources that Medicare Remit Easy Print is using, select 
Path Name Editor from the Tools menu.  
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2. The folder locations window appears showing the current folder location settings. 

 
 

 The Imported files: folder contains those files once the native 835 files have been 
imported into Medicare Remit Easy Print. 

 The Archive files: folder contains those files that have been archived from Medicare 
Remit Easy Print. 

 The Exported reports: folder contains those report files where the user chose to export 
the reports rather than printing them. 

 The X835 native files: folder contains the native 835 files that are imported into 
Medicare Remit Easy Print. 

Note: When an issue is reported and the ViPS MREP Team requests that the file be sent 
for further investigation, this is the type of file that needs to be sent. The file has a 
“.txt” extension. 

Identify the file/remittance advice that is in question or causing an issue. 

For the provider/supplier community, send a copy of this file to your contractor 
and your contractor should send the same file to the ViPS MREP Team. 

 The Resource files: folder contains the necessary internal files (004010X091A1.FLD or 
005010x221A1.FLD and loop.str) for Medicare Remit Easy Print to run. The Codes.ini 
file is also in this folder, but it is not required for Medicare Remit Easy Print to run. (Note: 
The Codes.ini file contains the descriptions of the Reason and Remark codes. If it is not 
present, the user receives a generic default message for each Reason and Remark code.)  
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Buttons 

 

Save changes made to the folders 

 

Reset the values for the files back to what they were when the 
Medicare Remit Easy Print application  was initially installed 

 

Exit the Medicare Remit Easy Print Folder Locations display box 
without saving changes 

 

 



Medicare Remit Easy Print Uninstalling Medicare Remit EasyPrint 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

40 

Uninstalling Medicare Remit EasyPrint 
1. Navigate to the Windows Control Panel Add/Remove Programs. 

• From the taskbar, click Start > Control Panel. 

• The control panel window opens. 

 
  

Windows 2000/XP control panel 
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2. Remove the Medicare Remit Easy Print Application. 

• Double click the Add/Remove Programs icon in the Control Panel. 

• Select Medicare Remit Easy Print from the resulting list. 

 

• Click Remove, then click Yes on the confirmation dialog. 

 

The Uninstall process is complete! 
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Online Help System 
The Medicare Remit Easy Print (MREP) Help online system allows you to look up 
information about MREP from MREP itself instead of referring to the Medicare Remit Easy 
Print User Guide. The online Help system is geared to the day-to-day tasks in MREP. It does 
not include information regarding the technical aspects of installing or running MREP on a PC 
or network. 

How to Access the Online Help System 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

 
 

2. Click Help. 
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Medicare Remit Easy Print opens the Medicare Remit Easy Print Help window and 
displays the introduction. 

Note: Be sure that the Medicare Easy Print Help dialog box is displaying the Contents tab 
in the left frame of the 
window.
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How to Use the Contents Tab 
1. To see what’s inside a book, click the + sign. 
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2. Click a topic to display the topic. 

 

At this point, you can: 

Print the topic 

Click  

View Options 

Click  

Return to the previous view 

Click  

Hide the tab 

Click  

3. To close the book, click the minus (–) sign on the keyboard. 
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How to Use the Index Tab 
1. Click the Index tab. 

 
2. Type a keyword to find. 
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3. Select a keyword by double clicking on it or click the display. 

 

How to Use the Search Tab 
1. Click the Search tab. 
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2. Type a keyword to find, then click the List Topics button  or type Alt + L. 

 
3. Once the list of topics appears, double click the one you want. 

 

How to Close the Medicare Remit Easy Print Help Window 
Click the close window button  or type Alt + F4. 
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Importing HIPAA 835 files 
The first time that you start Medicare Remit Easy Print, you must import an HIPAA 835 file. 

For the procedure for the first import, see Step 1 of How to Start Medicare Remit Easy Print. 
 

The first time you start Medicare Remit Easy Print, or when you don’t have any Remittance 
files in the Import folder you see the “No Remittance Files Found” dialog. Click or select the 
OK button to close the dialog. 

Before You Import the HIPAA 835 File 
Before you import an HIPAA 835 file, you must: 

• Install the Medicare Remit Easy Print program. (See PC Installations  or Network 
Installations) 

• To determine the location of the HIPAA 835 folder or where your HIPAA 835 files 
are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC. 

Import File Name Format 
When you import the HIPAA 835 file, Medicare Remit Easy Print makes a copy of it, renames 
it, and stores it in the Import file folder. 

The file-naming format is as follows: 

PPPPPPPPPPPPPPPPPPPPPPPPPPPPP  Payer Name – 30 bytes maximum 
 CCCCCCCCCCCCCCC Check/EFT # – 15 bytes maximum 

If a file has been imported successfully and you attempt to import the same file, an error 
record is written to the Import Exception Summary Window/Report and the file is not imported 
into the MREP application. Importing a file format other than HIPAA 835v5010A1 or 
835v4010A1, or a non-compliant version of a HIPAA 835-formatted file also writes a record 
to the Import Exception Summary window/report and the file is not imported into the MREP 
application. 

NOTE:  With the release of MREP v2.9 (April 2011), the only acceptable versions of the 
HIPAA 835 file that can be imported into MREP are 835v5010A1 and 835v4010A1. 
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Hint: 
For information 
about the very first 
time you import, 
see Step 1 on page 
28. 

How to Import the HIPAA 835 File 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

 
 

2. Click the Import button or go to the File menu option and select Import. 
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Medicare Remit Easy Print opens a window for you to select the HIPAA 835 file to 
import: 

 
3. Select the HIPAA 835 file that you want to import by double-clicking it 

Medicare Remit Easy Print starts the import and lets you know that it is importing: 

 
After the import finishes, the MREP Remittance Advice List window appears. 

At this point, you can: 

Work with the MREP Remittance Advices See Working with MREP Remittance Advices 
 

Work with Reports See Working with Reports 
.  
 

Note: Medicare Remit Easy Print reformats and saves a copy of the HIPAA 835 file. 
This copy is the Import file. If you import the same HIPAA 835 file more than once, 
Medicare Remit Easy Print bypasses the duplicate file and displays the Import 
Exception Summary Report indicating duplicate remittances were detected. 

For information about making sense of the Import file name, see Import File Name Format. 
. 
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How to Automatically Import the HIPAA 835 File 
1. Close Medicare Remit Easy Print. Right click on the Easy Print icon and click Properties. 

The EasyPrint.exe Properties window appears. 

 
Note: The values in the various fields vary for each MREP user. 

2. The Target: value needs to be modified to indicate the location of the files that are to be 
imported. The user must enter a space after the last double quote, the value of –I or –i (not 
case sensitive), followed by another space and the pathname. The pathname must be in 
double quotes. For example, "I:\Easy Print\EasyPrint.exe" –i "C:\MREP\Files to be 
imported\no_phi.txt" 
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3. To save the changes you made to the Target: value, you must click the Apply button. 

 
4. Once you click the Apply button, then you must click the OK button. The Properties 

window then disappears. 
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5. You can restart the MREP software. 
Notes:  

• If the user updates the Target field with a file path that does not exist, a message 
dialog appears stating the target file does not exist. Once the user chooses to close this 
window by clicking the OK button, the MREP software continues to run with the files 
that have already been imported. 

 
• Each time that the MREP software is invoked, it always accesses the import pathname 

to attempt to import the data that is contained in the specified file.  

• When a duplicate remit file or a file with an invalid data format (not 835v4010A1 or 
835v5010) is encountered, the Import Exception Summary window appears. The user 
can choose to Print or Close this window. Once the user chooses to close this window, 
the MREP software continues to run with files that have already been imported. 
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What to Do with an Import Error Message 
There are two error messages that you may see: 

For this error message: You need to: 

Invalid File Format Select the correct HIPAA 835 file to import. 
You have either selected an ERA not in a HIPAA 835 format or an 
ERA that is a HIPAA 835 with invalid delimiters. If you continue to 
receive this error, contact your contractor. 

Path / File Access Error Check with your network/PC administrator.  
You need to have read/write access rights to the Medicare Remit 
Easy Print directory. 

 



Medicare Remit Easy Print Importing HIPAA 835 files 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

56 

Import Exception Summary Window/Report 
The Import Exception Summary window/report helps to identify duplicate files, file 
formats other than 835v5010 or HIPAA 835v4010A, non-compliant HIPAA 835-
formatted files, and prevents the posting of “junk” files to the import folder. If any of 
the scenarios that are described above are encountered while attempting to import files 
to the MREP application, an Import Exception Summary dialog displays a list of 
invalid files by Payee and Check/EFT #, in addition to a brief description of the issue 
encountered. 
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You have the option of closing the window or printing the Import Exception Summary. If you 
choose to print the Import Exception Summary report, the window does not close 
automatically once the report prints. You need to close the window using the close button or 
“X-ing” out (top right corner of the Import Exception Summary window). The printing 
functionality for the Import Exception Summary report follows the existing printing 
functionality within MREP. Please note that if the window is closed prior to printing the 
report, the list of import error(s) is lost. To eliminate the need for file space management, a 
decision was made to not save the MREP Import Exception errors. To recreate the Import 
Exception Summary window, the files need to be imported again. 

The Import Exception Summary window and report contains three columns of information.  

• The first column of information is entitled “Payee”. Depending on what type of error 
is encountered during the import process, this field could contain data or spaces. The 
maximum number of bytes of data that can appear is 40.  

• The second column of information is entitled “Check/EFT #”. Depending on what type 
of error is encountered during the import process, this field could contain data or 
spaces. The maximum number of bytes of data that can appear is 15. 

• The third column of information is entitled “Reason”. Depending on what type of error 
that is encountered during the import process, there is the possibility of three different 
messages appearing. 

Prior to the three columns of data, the Import Exception Summary window and report 
contains a heading with the title “File:”. The information following the “File:” heading is the 
location and name of the file that the attempt is being made to import into the MREP 
application.  

When the Import Exception Summary report prints, the printed version contains an additional 
heading prior the “File:” heading. It is the first heading on the report. On the left side of the 
page, the heading displays “Import Exception Summary”. In the center of the page, the 
heading displays the date and time stamp when the summary report was printed. The format 
of the date is MM/DD/CCYY. Please note that the leading zero in the month and day do not 
appear – for example: 2/15/2006. The format of the time is HH:MM:SS XX (XX represents 
AM or PM). On the right side of the page, the heading displays the version of the MREP 
application that is being used (for example: Easy Print v1.7). 
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Working with MREP Remittance Advices 

How to View a List of Claims for an MREP Remittance Advice 
 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

2. Select the Remittance Advice by clicking on it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the associated 
claims below. 

 

This is the 
Remittance 

Advice for 
this claim. 

You clicked 
Payee 1. 

These are 
the claims 

for Payee 1 
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Note:  Some screen reading applications may not be able to read all of the values on the 
claim list tab. Function key F1 displays an accessibility informational message allowing the 
screen reading application to recite the field names and values displayed in the listview for the 
highlighted claim. Please note the Patient’s Name appears the Last Name first, followed by a 
comma and then the First Name:  

 

At this point, you can: 

Find out more about this tab See page Making Sense of the Claim List Tab 
 

Print the list Click   or go to the Tab menu 
option and select Print Claim List, or type Alt + B 
+ P. 
For more info, see How to Print a List of Claims. 

View claim details Click  or go to the View 
menu option and select Claim Detail 
For more info, see How to View the Detail for a 
Claim 
  

View a Summary for the Remittance 
Advice  

Click  or go to the View 
menu option and select Remit Summary 

For more info, see How to View the Total 
Amounts for a Remittance Advice.   

View the data that feeds the Remittance 
Advice  

Click  or go to the View 
menu option and select Data View 

For more info, see Making Sense of the Data 
View Tab. 

Search Click  or go to the View 
menu option and select Search 

For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for the 
Remittance Advice 

Click  or go to the View 
menu option and select Glossary. 
For more info, see Making Sense of the Glossary 
Tab. 
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How to View the Detail for a Claim 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking on it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below. 

 
Hint: 
You can click 
on a column 
heading to 
change the 
sort order. 

You clicked 
Payee 1 

These 
are the 

claims for 
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3. Check the checkbox next to the claim(s) that you want to see detail. Detailed information 
only appears for claims that are checked. 

 
 

4. Click the Claim Detail tab.
Click to print 

the detail 

Hint: 
You can use 
the Check All 
and Uncheck 
All buttons to 
help you select 
the claims. 
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The detail appears for the claim you selected: 

 
 
 

Find out more about this tab See page Making Sense of the Claim Detail. 

Print the detail 
Click the print button,        
or go to the Tab menu option and select Print 
Claim Detail, or type Alt + B + P. 
For more info, see How to Print the Detail for a 
Claim. 

Return to the Claim List  
Click the claim list tab      
or go to the View menu option and select Claim 
List. 
For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 
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View a Summary for the Remittance Advice  Click the summary tab     

or go to the View menu option and select Remit 
Summary. 
For more info, see How to View the Total 
Amounts for a Remittance Advice. 

View the data that feeds the Remittance 
Advice 

Click the Data  View tab   

or go to the View menu option and select Data 
View. 
For more info, see Making Sense of the Data 
View Tab. 

Search 
Click  the Search Tab     

or go to the View menu option and Search. 
For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for the 
Remittance Advice Click  the Glossary Tab  

or go to the View menu option and select 
Glossary. 
For more info, see Making Sense of the 
Glossary Tab. 

Option to print or suppress the printing of 
the glossary of CARCs and RARCs for the 
Remittance Advice (not available for 
Remittance Advices printed from the menu 
bar or toolbar) 

A check box with the word Glossary appears in 
the lower right side of the Claim Detail tab. 
When this check box is checked, the glossary 
of CARCs and RARCs involved with a 
particular MREP Remittance Advice prints on a 
separate page. When the check box is not 
checked, the glossary of CARCs and RARCs 
involved with a particular MREP Remittance 
Advice does not print.  
 
The user also has the option via the Tab menu 
option to show or not show the glossary of 
CARCs and RARCs involved with the MREP 
Remittance Advice. 
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How to View the Total Amounts for a Remittance Advice 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking on it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below. 

3. Click the Remit Summary Tab  or type Alt + V + S.  
Medicare Remit Easy Print displays the totals, for example 

 

Click the print  
button   

or type Alt + B + 
P to print the 

summary 
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At this point, you can: 

Find out more about this tab See Making Sense of the Remit Summary Tab. 
 

Print the summary 
Click  the print button          
or go to the Tab menu option and select Print 
Claim Detail or type Alt + B + P. 

 
View claim details Click the Claim Detail Tab  

or go to the View menu option and select Claim 
Detail 
For more info, see How to View the Detail for a 
Claim. 
 

 
Return to the Claim List  Click the Claim List tab       

or go to the View menu option and select Claim 
List 
For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 
 

View the data that feeds the Remittance 
Advice 

Click  the Data View tab      
or go to the View menu option and select Data 
View 
For more info, see Making Sense of the Data 
View Tab. 

Search Click the Search tab            
or go to the View menu option and select Search 
For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for the 
Remittance Advice 

Click the Glossary tab         
or go to the View menu option and select 
Glossary 
For more info, see Making Sense of the Glossary 
Tab. 
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How to View the Data in the Import File 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking on it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below. 

3. Click the Data View Tab  or type Alt + VV. 
Medicare Remit Easy Print displays the file format: 

  

 

 

At this point, you can: 

Select a loop 
& segment 

The contents of the loop 
& segment appear here 
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Find out more about this window See page Making Sense of the Data View Tab. 

View claim details Click the Claim Detail  tab   

Or, go to the View menu option and select 
Claim Detail. 

For more info, see How to View the Detail for a 
Claim. 
 

Return to the Claim List  
Click the Claim List  tab     

Or, go to the View menu option and select 
Claim List. 

For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 

View a Summary for the Remittance 
Advice  Click the Summary  tab    

Or, go to the View menu option and select 
Remit Summary. 

For more info, see How to View the Total 
Amounts for a Remittance Advice. 

Search Select the Search  tab      

Or, go to the View menu option and select 
Search. 

For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for the 
Remittance Advice 

Select the Glossary  tab    

 

Or, go to the View menu option and select 
Glossary. 

For more info, see Making Sense of the 
Glossary Tab. 
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How to View the CARC and RARC Codes 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

2. Select the Remittance Advice by clicking on it. 

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below. 

3. Click the Glossary Tab  or type Alt +V + G. 

Medicare Remit Easy Print shows the Reason and Remark codes for the Remittance 
Advice: 

 

 
Click the Codes button or 
type Alt + B + C to  see a 
comprehensive list of 
codes and descriptions. 
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At this point, you can: 

 
Find out more about this tab See page Making Sense of the Glossary Tab. 

View claim details Click the Claim Detail tab   
or go to the View menu option and select Claim 
Detail. 
For more info, see How to View the Detail for a 
Claim. 
 

Return to the Claim List  Click the Claim List  tab      
or go to the View menu option and select Claim 
List. 
For more info, see How to View a List of Claims 
for an MREP Remittance Advice. 
.  

View a Summary for the Remittance 
Advice  

Click the Summary tab     

or go to the View menu option and select Remit 
Summary. 
For more info, see How to View the Total 
Amounts for a Remittance Advice. on page 91. 

View the data that feeds the Remittance 
Advice 

Select the Data View tab   
or go to the View menu option and select Data 
View. 
For more info, see Making Sense of the Data 
View Tab. 

Search Select the Search tab       
or go to the View menu option and select Search. 
For more info, see How to Search Payment 
Information. 

View the CARCs and RARCs for the 
Remittance Advice Click the Codes button   at the 

bottom of the tab or type Alt + B + C. 
For more information, see How to View the 
CARC and RARC Codes. 
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How to Look up a CARC/RARC Code 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

1. On the menu Select Tools > Code Descriptions.  

The Code Descriptions window opens.  
 

 

 

Type a specific 
code or click a 
code to display 
its description 

and notes 

The Note window 
displays any notes  

about the 
CARC/RARC Code 

The Description 
window displays 
verbiage for the 
CARC/RARC 

Code 
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How to Update (Import) the CARC/RARC Codes 
At a minimum, the ANSI Claim Adjustment Reason Code (CARC) and Remittance Advice 
Remark Code (RARC) file requires an update three times a year. When the list of codes is updated 
per Washington Publishing Company, VIPS provides an updated file on the VIPS Assist website 
for the contractors and CMS provides a link to the updated file on the CMS website for the 
provider/supplier community. When the user finds it necessary to import this updated file into 
MREP, follow these instructions: 

1.    Access the list of the latest codes from the VIPS Assist or CMS website. 

2. Save the list of latest codes so that they are easily accessible. 

Note: The file name must be saved as Codes.ini in order for MREP to successfully find 
the code file. 

3. Select “Import Code Descriptions” from the Tools menu. 
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A dialog window appears asking to confirm the code import. 

 

 

  

 

 

 

If you select the NO button, the dialog box disappears and no updates are made to 
MREP. If you select the YES button, a file dialog box appears. 

 

4. Navigate to the folder or area where you saved the file under step 2. Select the Codes.ini 
file and  then click the Open button. 

To replace the existing 
CARC/RARCs, click Yes. 

If you don’t want to replace 
the existing CARC/RARCs, 
click No.
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5. After you press the Open button, a dialog displays confirming the code import was 
successful. Click, or select the OK button to close the dialog. 

 

 

   Click OK. 

6. The latest list of CARC/RARCs exists in the MREP application. To verify that the latest 
version exists, select “Code Descriptions” from the Tools menu.  

Click the Open button. 
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7. The Easy Print – Reason/Remark/Group Codes dialog box appears.  

 
Note: The Easy Print – Reason/Remark/Group Codes dialog box includes the date of the 

latest version of the code list. 
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How to Print a List of Claims 
1. View the list of claims. 

For the steps to follow, see How to View a List of Claims for an MREP Remittance Advice. 

 

2. Click the print button  at the bottom of the tab or type Alt + B + P.  
The Print remit listing window opens. 

3. Print the detail listing in one of the following ways: 

A. From the Print remit listing window, click Print to print the detail without previewing 
it. 

 
The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print remit listing window, click Preview to view a preview of the printed 
page before printing. 
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The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 

 

At this point, you can: 

View claim details Click the Claim Detail  tab   
or go to the View menu option and select Claim 
Detail  
For more info, see How to View the Detail for a 
Claim. 
 

Search Click the Search tab           
or go to the View menu option and select Search 
For more info, see How to Search Payment 
Information. 

View a Summary for the Remittance 
Advice 

Click the Summary tab       
or go to the View menu option and select Remit 
Summary 
For more info, see How to View the Total 
Amounts for a Remittance Advice.  

View the data that feeds the Remittance 
Advice 

Click the Data View tab      
or go to the View menu option and select Data 
View 
For more info, see Making Sense of the Data 
View Tab. 

View the CARCs and RARCs for the 
Remittance Advice 

Click  the Glossary tab       

 
or go to the View menu option and select 
Glossary 
 For more info, see How to View the CARC and 
RARC Codes. 
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How to Print the Detail for a Claim 
1. View the detail for the claim.  

For the steps to follow, see How to View the Detail for a Claim. 
 

2. Click the print button  at the bottom of the tab, or type Alt + B + P. The 
Print remit listing window opens. 

 
3. Print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 

The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 
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B. Click Preview to view a preview of the printed page before 

printing.  

The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Print the Remittance Advice Summary 
1. View the Remittance Advice Summary. 

For the steps to follow, see How to View the Total Amounts for a Remittance Advice. 

2. Click the print button  at the bottom of the tab, or type Alt + B + P.  

The Print remit listing window opens. 

3. Print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 

 
The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
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B. Click Preview to view a preview of the printed page before printing. 

 
The Print Preview window opens. 

 

Click the printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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Searching Payment Information 
You can search by: 

• HICN 

• Bene Last Name 

• ICN 

• Bene Account Number 

• Procedure code 

• Service date (range of dates in the format MM/DD/YY, MM/DD, MM/YY, DD/YY, 
MM, DD, or YY; forward slashes are not required when entering a value in the ‘Value 
to Find’ field) 

• Rendering Provider Number 

• Adjusted Lines 

• COB Claims 

• Non-COB Claims 

• Deductible/Coins Lines 

• Coinsurance Lines 

• Deductible Lines 

• Other Adjustments 

• Denied Lines  

• NDC 

• MSP Claims 

• Non-MSP Claims 
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How to Search Payment Information 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  
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2. Click the Search button or the Search tab. 

The Search tab opens.  

 

Search tab 

Use the drop-
down list to 

select the field 
you want to 
search on. 

When 
applicable, 

enter the value 
to find. 

If available, 
select the radio 

button that 
corresponds 

with your entry 
in the Value to 

find: field.  
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Hint: 
You can use a 
calendar date 
picker to select 
a service date. 

Hint: 
You cannot use 
a wild card 
character in 
the search. 

 

3. Use the drop-down list to select a search field. 

If applicable, enter the value to find. The Search tab includes three radio buttons for how 
the field should be searched (Exact Match, Begins With, or Contains).  

To display the “searched” data, you must select one of the radio buttons before clicking 
the Search button. The Exact Match, Begins With, and Contains radio buttons are only 
available for the HICN, ICN, Bene Account Number, Bene Last Name, NDC, Procedure 
Code, and Rendering Provider fields.  

If the Search: field is not one of these fields, the Exact Match, Begins With, and Contains 
radio buttons are not available. 

If you select one of the Service Date formats from the drop-down menu, you can: 

• Enter the date in the Value to find field 
• Use the drop-down list only to access the Calendar picker for the MM/DD/YY 

format only. Use the left and right arrows to select the month, and then click on 
the date you want. 
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5. Click the Search type to start the search. 

Medicare Remit Easy Print returns all of the claim lines/info that match the search.  

For example, imagine you needed to view all of Sally Doe’s claims. If the remit contains 
any claim lines with the name Doe, the Search Tab listview is updated with those claim 
lines matching the criteria. 
 
 

 

The search was 
for Sally Doe’s 

claims. 

Hint: 
You can change 
the sort order 
by clicking a 
column 
heading. 

Click the Claim Detail 
Tab  or type Alt + B + C 
to display the details for 

these claims 

Click the print 
button or type 
Alt + B + P to 
print this list of 

claims 

Hint: 
If you cannot 
see all the 
columns, use 
the horizontal 
scroll bar at the 
bottom of the 
screen. 



Medicare Remit Easy Print Working with MREP Remittance Advices 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

86 

Hint: 

Hint: 
Key F1 displays a 
dialog containing 
the listview field 
names and 
values. This 
enables screen 
reading programs 
to read all the 
listview fields for 
a highlighted 
claim. 

Making Sense of the Claim List Tab 
For the procedure to view the claim list, see How to View a List of Claims for an MREP 
Remittance Advice. 
 
The claim list tab displays a summary of all of the claims found within the selected remittance: 

 
 

Name This is the name of the beneficiary that the claim was processed for. 
The name field is defined as Last Name followed by the First Name. 
A comma separates the two names. 

ACNT This is any internal number assigned to the claim by the provider. 

ICN This is the Internal Control Number (ICN), the unique number 
assigned to the claim when it is received by the contractor.  

Billed Amount This is the total claim dollar billed amount. 

Paid Amount This is the total claim provider billed amount. 

Claim List 
tab 

Hint: 
Click on a 
column 
heading to 
change the 
sort order. 
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From Date This is the earliest From Date of service on the claim. 

To Date This is the latest To Date of service on the claim. 

ASG This indicates whether or not the provider has accepted assignment 
for the claim. 

Buttons 

 
Print the list. (type Alt + B + P) 

 

Select all of the claims. (type Alt + B + C) 

 

Unselect all of the claims. (type Alt + B + U) 
 

 

Display Claim(s) 
 
 

From the 
Tab menu 
option select 
Display 
Claim 
 
 
 
 
 
 
 
 
 
 

Select claims in the claim list by enabling the checkbox for the corresponding claim. To 
display the selected claims, from the Tab menu option select Display Claim. 
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EasyPrint displays the claim(s) information in a vertical line-by-line format. 

 

 
 

This format provides the claim data at a glance and allows screen reading software to 
interpret the data more easily. 
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Making Sense of the Claim Detail Tab 
For the procedure to view claim detail, see How to View the Detail for a Claim. 
 
The claim detail tab displays all the claim information for each claim(s) that has been checked 
on the Claim List tab. 

 
 
INFORMATION FOR THE CLAIM: 

Note: Some fields described below do not appear in the above image. 
 
First Line of Claim Line  

NAME This is the name of the beneficiary for whom the claim was 
processed. 

HIC This is the Health Insurance Claim (HIC) number of the beneficiary 
for whom the claim was processed. 

ACNT This is any internal number assigned to the claim by the provider. 

Service 
lines 

Service 
line 
headers 

Information 
for the 
claim 

Claim Detail tab 
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ICN This is the Internal Control Number (ICN), the unique number 
assigned to the claim when it is received by the contractor. 

ASG This indicates whether or not the provider has accepted assignment 
for the claim. 

MOA This contains remark codes at the claim level. 

REND-PROV This is the performing provider ID number.  

SERV-DATE  This is the date(s) of service. 

POS This is the two-digit Place of Service (POS) code.  
A list of POS codes is available here: 
http://www.cms.gov/manuals/downloads/clm104c26.pdf 
 

PD-PROC This is the HCPCS procedure code. 
A list of these codes is available here: 
https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf  

MODS These are all the modifiers billed with the procedure. 

PD-NOS This is the number of services rendered. 

BILLED This is the amount the provider billed for the service. 

ALLOWED This is the allowed amount for the service. 

DEDUCT This the amount of any deductible applied to the claim. This is the 
amount that the beneficiary (or other insurer, if applicable) is 
responsible for paying the provider. 

COINS This is the amount that the beneficiary (or other insurer, if applicable) 
is responsible for paying the provider. 

PROV-PD This is the amount the provider was paid for the service. 

 
Second Line of Claim Line 

RARC These are the Remark Codes at the line level. 

SUB-NOS This is the submitted number of services. 

SUB-PROC This is the submitted HCPCS procedure code. 

GRP/CARC These are any Group Codes and Claim Adjustment Reason Codes 
for the service line. 

CARC-AMT This is the amount of any adjustment made based on the Group and 
Claims Adjustment Reason Code. 

ADJ-QTY This is the quantity of units of service being adjusted. 

CNTL # This is the line item control number. 

HCPI This is the Healthcare Policy Identification number. 

http://www.cms.gov/manuals/downloads/clm104c26.pdf
https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf
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Totals 

PT RESP This is the total amount that the beneficiary owes the provider for this 
claim. 

CLAIM TOTALS This includes the totals for all service-line level amounts: 
BILLED 
ALLOWED 
DEDUCT 
COINS 
PROV-PD 

ADJ TO TOTALS:  

 PREV PD This field is blank in Medicare Remit Easy Print. 

 INTEREST This is the interest amount paid for claims processing time. 

 LATE FILING 
CHARGE 

This is the late filing charge. 

 NET This is the amount that Medicare owes the provider for this claim. 

CLAIM 
INFORMATION 
FORWARDED TO: 

This appears when the claim is being forwarded to a beneficiary’s 
supplemental insurer. 

CORRECTED 
PRIORITY PAYER 
INFO: 

This is the corrected priority payer name and/or id number. 

OTHER CLAIM REL 
IDENTIFICATION: 

This is additional information relevant to the adjudication of the claim 
and a qualifier identifying the type of reference information. 

GLOSSARY These are the Reason and Remark codes that are also shown on the 
Glossary tab. 

Buttons 

 
Print the claim detail. (type Alt + B + P) 

 

Zoom in to make the size of the type larger. (type Alt + B + I) 
 

 

Zoom out to make the size of the type smaller. (type Alt + B + O) 
 

 
Reset the type to the original size. (type Alt + B + R) 

 
Appears CARCs/RARCs and descriptions for the selected claims 
when checked. (type Alt + B + S) 
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Making Sense of the Remit Summary Tab 
For the procedure to view the Remittance Advice detail, see How to View the Total Amounts 
for a Remittance Advice. 

The Remit Summary Tab displays total dollar amounts, claim counts, and provider adjustment 
information if present in the selected remittance. 

 
 
PROVIDER NAME 

 
This is the provider’s name. 

PROVIDER # This is the provider’s ID number. 

CHECK DATE This Is the date of the check. 

CHECK /EFT TRACE 
NUMBER 

This is the tracking number for the check or EFT. 

TOTAL CLAIMS This is the total number of claims. 

BILLED AMOUNT This is the total billed amount. 

TOTAL REASON 
CODE ADJUSTMENT 

This is the total adjustment amount. 

Remit 
Summary 

tab 
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AMOUNT 

TOTAL ALLOWED 
AMOUNT 

This is the total allowed amount. 

TOTAL 
COINSURANCE 
AMOUNT 

This is the total amount of coinsurance applied. 

TOTAL DEDUCTIBLE 
AMOUNT 

This is the total deductible amount. 

TOTAL PAID TO 
PROVIDER 

This is the total amount paid to provider. 

TOTAL INTEREST 
AMOUNT 

This is the total amount of interest applied. 

TOTAL CHECK /EFT 
AMOUNT 

This is the total amount of the check. 

PLB ADJ DETAILS This is the remittance-level (PLB) adjustment. This field only appears 
if a remittance-level adjustment is present. 

Buttons 

 
Print the summary. (type Alt + B + P) 

 

Zoom in to make the size of the type larger. (type Alt + B + I) 
 

 
Zoom out to make the size of the type smaller. (type Alt + B + O) 

 
Reset the type to the original size. (type Alt + B + R) 
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Making Sense of the Data View Tab 
For the procedure to view the data, see How to View the Data in the Import File. 

The Data View Tab displays the remittance fields as they are stored internally in MREP. The 
data are stored in what are referred to as Segments. Each segment contains a varying number 
of elements or fields. 

 

The HIPAA 835v4010A1 and 835v5010 formats separate data into segments and loops. To 
understand how to read segments and loops, refer to the X12 835 Implementation Guides. 
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Making Sense of the Search Tab 
For the procedure to view the data, see How to Search Payment Information. 

The Search Tab displays a summarized list of claim information that matches the criteria of 
the user’s search. The Name field’s format is the beneficiary’s Last Name, followed by a 
comma and then the First Name. 

 
Buttons 

 

Print the list of claims from the search. (type Alt + B + P) 

 

View details for all of the claims from the search. (type Alt + B + C) 
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Making Sense of the Glossary Tab 
For the procedure to view the data shown in the Glossary Tab see How to View the CARC and 
RARC Codes. 

The Glossary tab displays the CARC/RARC codes and descriptions for the selected 
remittance. 

 
Buttons 

 
Zoom in to make the size of the type larger. (type Alt + B + I) 

 

 
Zoom out to make the size of the type smaller. (type Alt + B + O) 
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Reset the type to the original size. (type Alt + B + R) 

 

Displays CARCs/RARCs and descriptions for the selected claims 
when checked. (type Alt + B + S) 
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Working with Reports 
Medicare Remit Easy Print provides 11 different reports, including: 

• Denied Service Lines 

• Adjusted Service Lines 

• Deductible Service Lines 

• Coinsurance Service Lines 

• Deductible/Coinsurance Service Lines 

• COB Claims Report 

• Non-COB Claims Report 

• MSP Claims Report 

• Non-MSP Claims Report 

• Other Adjustment Report 

• Entire Remittance 
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Making Sense of the Denied Service Lines Report 
This report displays claim service lines that have an allowed amount equal to zero and are 
associated with a claim that does NOT have a claim status 22 (reversed claim). The report 
includes only the lines on the claim that meet these criteria.  
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Making Sense of the Adjusted Service Lines Report 
This report displays claims that have a status of 22 (reversed claim). 

This report does NOT show the adjustment claim that reflects the corrected dollar amounts. 
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Making Sense of the Deductible Service Lines Report 
This report shows claim service lines that have deductible amounts greater than zero, as well 
as those service lines with only deductible amounts greater than zero. It includes only the lines 
on the claim that meet these criteria. 
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Making Sense of the Coinsurance Service Lines Report 
This report shows claim service lines that have coinsurance amounts greater than zero, as well 
as those service lines with only coinsurance amounts greater than zero. It includes only the 
lines on the claim that meet these criteria. 
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Making Sense of the Deductible/Coinsurance Service Lines Report 
This report shows claim service lines that have both deductible and coinsurance amounts 
greater than zero, as well as those service lines with only coinsurance and deductible amounts 
greater than zero. It includes only the lines on the claim that meet these criteria. 
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Making Sense of the COB Claims Report 
This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that were crossed 
over. The requirement for crossover claims to print on the report is that the 2100 loop, CLP02 
data field must contain one of the following values: 

19 Processed as Primary, Forwarded to Additional Payer(s) 

20 Processed as Secondary, Forwarded to Additional Payer(s) 

21 Processed as Tertiary, Forward to Additional Payer(s) 
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Making Sense of the Non-COB Claims Report 
This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that did not cross 
over. The requirement for claims to print on the report is that the 2100.CLP02 data field does 
not contain one of the following values: 

19 Processed as Primary, Forwarded to Additional Payer(s) 

20 Processed as Secondary, Forwarded to Additional Payer(s) 

22 Processed as Tertiary, Forward to Additional Payer(s) 
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Making Sense of the MSP Claims Report 
This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or 
835v5010 file that were processed by Medicare as secondary. The claims have a value of 2 
(Processed as Secondary) or 20 (Processed as Secondary, Forwarded to Additional Payer(s)) in 
the 2100 loop, CLP02 data field. 
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Making Sense of the Non-MSP Claims Report 
This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or 
835v5010 file that were processed by Medicare as primary. The claims have a value of 1 
(Processed as Primary) or 19 (Processed as Primary, Forwarded to Additional Payer(s)) in the 
2100.CLP02 data field. 
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Making Sense of the Other Adjustments Report 
This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that had some 
type of adjustment. Claims that have Late Filing and Interest and remittances that have 
Withholding and a Forwarding Balance print on the report. 
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How to Print the Denied Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 
 

2. Click the down arrow on the Report button. 
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The Report List appears.  

 
3.  Select Denied Service Lines.  



Medicare Remit Easy Print Working with Reports 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

111 

4. The Print and Export options appear:   

 
5. Select Print. 

The Print denied line report window opens. 

 
6. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens, for example: 

 
If you need to change the properties, click Properties and make changes as 
necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print denied line report window, click Preview to view a preview of the 
printed page before printing. 

 
The Print Preview window opens. 

 

 

 

 

 

 

 

 

 

 

Click the printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Denied Service Lines Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select Denied Service Lines. 

  



Medicare Remit Easy Print Working with Reports 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

115 

The Print and Export options appear. 

 

 
4. Select Export. 
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The Export folder window opens. 

 
 

5. Enter the file name. 

6. Click the Save button. 

Hint: 
When you export, 
the default folder 
is the ReportExport 
folder in the 
Medicare Remit 
Easy Print 
directory.  
 
You can select 
another location 
using the Save in 
drop-down list. 
menu. 
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How to Print the Adjusted Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select Adjusted Service Lines. 
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The Print and Export options appear. 

 
4. Select Print. The Print remit listing window appears. 

5. From the Print remit listing window, print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 
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The Print dialog opens, for example: 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. Click Preview to view a preview of the printed page before printing. 

 
The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Adjusted Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select Adjusted Service Lines. 
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The Print and Export options appear. 

 
4. Select Export. 
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The Export folder window opens. 

 
 

5. Enter the file name. 

6. Click the Save button. 

Hint: 
When you 
export, the 
default folder 
is the 
ReportExport 
folder in the 
Medicare Remit 
Easy Print 
directory. You 
can select 
another 
location using 
the Save in 
drop-down list. 
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How to Print the Deductible Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductive/COINS Service Lines report options appear. 

 
4. Select Deductible Lines: 
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5. Select Print. The Print remit listing window appears. 

 

6. Print the detail listing in one of the following ways: 

A. Click Print to print the detail without previewing it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. Click Preview to view a preview of the printed page before printing. 

 
The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Deductible Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductible/COIN Service Lines report options appear. 

 
4. Select Deductible Lines. 
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5. Select Export.
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The Export folder window opens. 

 
 

6. Enter the file name. 

7. Click the Save button. 

 

Hint: 
When you 
export, the 
default folder 
is the 
ReportExport 
folder in the 
Medicare Remit 
Easy Print 
directory. You 
can select 
another 
location using 
the Save in 
drop-down list. 
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How to Print the Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

 
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears.  

 
2. Select Deductible/COINS Service Lines. 
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The Deductible/COINS Service Lines report options appear. 

 
3. Select Coinsurance Lines. 
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4. Select Print. The Print remit listing window appears. 

5. Print the detail listing in one of the following ways: 

A. From the Print remit listing window, click Print to print the detail without previewing 
it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print remit listing window, click Preview to view a preview of the printed 
page before printing. 

 



Medicare Remit Easy Print Working with Reports 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

140 

The Print Preview window opens. 

 

B. Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductible/COIN report options appear. 

 
4. Select Coinsurance Lines. 
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5. Select Export. 



Medicare Remit Easy Print Working with Reports 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

145 

The Export folder window opens. 

 
 

6. Enter the file name. 

7. Click the Save button. 

 

Hint: 
When you export, 
the default folder is 
the ReportExport 
folder in the 
Medicare Remit Easy 
Print directory.  
 
You can select 
another location 
using the Save in 
drop-down list. 
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How to Print the Deductible/Coinsurance Service Lines Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears.  

 
3. Select Deductible/COINS Service Lines. 
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The Deductible/COIN report options appear. 

 
4. Select Deductible & Coinsurance Lines: 
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5. Select Print.  

The Print remit listing window appears. 

1. Print the detail listing in one of the following ways: 

A.  From the Print remit listing window, click Print to print the detail without previewing 
it. 
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The Print dialog opens.  

If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print remit listing window, click Preview to view a preview of the printed 
page before printing. 

 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Deductible/Coinsurance Service Lines Report 
2. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

 
3. Click the down arrow on the Report button. 
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The Report List appears.  

 
4. Select Deductible/COINS Service Lines. 
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The Deductible/COINS report options appear. 

 
5. Select the Deductible & Coinsurance Lines: 
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6. Select Export. 
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The Export folder window opens. 

               
 

6. Enter the file name. 

7. Click the Save button. 

 

Hint: 
When you export, 
the default folder is 
the ReportExport 
folder in the 
Medicare Remit 
Easy Print directory. 
You can select 
another location 
using the Save in 
drop-down list. 
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How to Print the COB Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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The Print and Export options appear. 

 
4. Select COB Claims. 
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5. Select Print. 

The Print denied line report window opens. 

6. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print denied line report window, click Preview to view a preview of the 
printed page before printing. 

 
The Print Preview window opens. 

 

 

 

 

 

 

 

 

 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the COB Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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4. Select COB Claims. 
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 The Print and Export options appear. 

 
5. Select Export. 
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The Export folder window opens. 

 
 

5. Enter the file name. 

6. Click the Save button. 

 

Hint: 
When you export, 
the default folder is 
the ReportExport 
folder in the 
Medicare Remit 
Easy Print 
directory. You can 
select another 
location using the 
Save in drop-down 
list. menu. 
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How to Print the Non-COB Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
2. Select COB/Non-COB Claims.  
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3. Select Non-COB Claims. 

The Print and Export options appear. 
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4. Select Print. 

The Print denied line report window opens. 

5. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens, for example: 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print denied line report window, click Preview to view a preview of the 
printed page before printing. 

 
The Print Preview window opens. 

 

 

 

 

 

 

 

 

 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Non-COB Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print 
icon.   

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select COB/Non-COB Claims.  
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4. Select Non-COB Claims. 



Medicare Remit Easy Print Working with Reports 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

174 

 The Print and Export options appear. 

 
5. Select Export. 
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The Export folder window opens. 

 
 

6. Enter the file name. 

7. Click the Save button. 

Hint: 
When you 
export, the 
default folder 
is the 
ReportExport 
folder in the 
Medicare Remit 
Easy Print 
directory. You 
can select 
another 
location using 
the Save in 
drop-down list. 
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How to Print the MSP Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print 

icon.   

The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select MSP Claims. 
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The Print and Export options appear. 

 
5. Select Print. 
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The Print denied line report window opens. 

6. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 

 
The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print denied line report window, click Preview to view a preview of the 
printed page before printing. 
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The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the MSP Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 
 

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select MSP Claims. 
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The Print and Export options appear. 

 
5. Select Export. 
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The Export folder window opens. 

 
 

5. Enter the file name. 

6. Click the Save button. 

 

Hint: 
When you export, 
the default folder is 
the ReportExport 
folder in the 
Medicare Remit 
Easy Print 
directory. You can 
select another 
location using the 
Save in drop-down 
list. menu. 
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How to Print the Non-MSP Claims Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 
1. Click the down arrow on the Report button. 
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The Report List appears. 

 
2. Select MSP/Non-MSP Claims.  
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3. Select Non-MSP Claims. 

The Print and Export options appear. 
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4. Select Print. 

The Print denied line report window opens. 

5. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print remit listing window, click Preview to view a preview of the printed 
page before printing. 

 
The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Non-MSP Claims Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select MSP/Non-MSP Claims.  
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4. Select Non-MSP Claims. 
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 The Print and Export options appear. 

  
5. Select Export. 
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The Export folder window opens. 

 
 

6. Enter the file name. 

7. Click the Save button. 

Hint: 
When you export, 
the default folder is 
the ReportExport 
folder in the 
Medicare Remit Easy 
Print directory. You 
can select another 
location using the 
Save in drop-down 
list.  
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How to Print the Other Adjustments Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select Other Adjustments. 
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The Print and Export options appear. 

 
4. Select Print. 

The Print denied line report window opens. 

5. Print the detail listing in one of the following ways: 

A. From the Print denied line report window, click Print to print the detail without 
previewing it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print denied line report window, click Preview to view a preview of the 
printed page before printing. 

 
The Print Preview window opens. 

 

 

 

 

 

 

 

 

 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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How to Export the Other Adjustments Report 
You export the report in .csv (comma separated values) format. 

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print 
icon.   

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select Other Adjustments. 
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The Print and Export options appear. 

 
4. Select Export Report. 
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The Export folder window opens. 

 
 

5. Enter the file name. 

6. Click the Save button. 

 

Hint: 
When you export, the 
default folder is the 
ReportExport folder in 
the Medicare Remit 
Easy Print directory.  
 
You can select 
another location using 
the Save in drop-
down list menu. 
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How to Print the Entire Remittance Report 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print 

icon.   

The Medicare Remit Easy Print Claim List tab opens.  

 
2. Click the down arrow on the Report button. 
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The Report List appears. 

 
3. Select Entire Remittance. 

The Print remit listing window appears. 

4. Print the detail listing in one of the following ways: 

A. From the Print remit listing window, click Print to print the detail without previewing 
it. 
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The Print dialog opens. 

 
If you need to change the properties, click Properties and make changes as necessary. 

Click OK. Medicare Remit Easy Print prints the detail at your default printer. 

B. From the Print Remit listing window, click Preview to view a preview of the printed 
page before printing. 

 
The Print Preview window opens. 

 

Click printer button  at the top of the window. 

Medicare Remit Easy Print prints the detail at your default printer. 
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Housekeeping for the Import Files 
Housekeeping includes: 

• Archiving files 

• Restoring files 

• Deleting files 

Archiving Import Files 
Medicare Remit Easy Print does NOT automatically archive any Import file, and Import files 
can slow down the processing time of the PC. 

Therefore, Medicare Remit Easy Print lets you archive Import files. The location you choose 
for the archive must have adequate security to protect PHI. 

How to Archive Import files 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 
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The Medicare Remit Easy Print Claim List tab opens. 

 
2. On the top of the window, select the file that you want to archive and click the Archive 

button. 
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The Archive Imported Files window opens. 

 
 

3. Select the file(s) you want to archive by checking the box(es).  

This activates the Archive button. 

4. Click the Archive button. 

Medicare Remit Easy Print moves the file to the Archive folder. 

Hint: 
You can use the 
Browse button to 
specify another 
location for the 
archived file. 

 
   
   

  
   
 

Pathname for 
the Archive 

folder 

Hint: 
When you need to archive 
all the payers in the list, 
you can place a checkmark 
in the Check All box to 
archive all the claim files.  
 
When you check that option 
a checkmark is placed in 
front of all claims in the list. 
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Restoring Import files 
You can restore an Import file after you have archived it. 

For information about archiving Import files, see Archiving Import Files. 
 

How to Restore Import files 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon 

 . 

The Medicare Remit Easy Print Claim List tab opens. 

 
2. On the top of the window, click the Restore button. 



Medicare Remit Easy Print Housekeeping for the Import Files 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

212 

The Restore Imported Files window opens. 

 
3. Select the file(s) you want to restore by checking the box(es).  

This activates the Restore button. 

4. Click the Restore button. 

Medicare Remit Easy Print moves the file from the Archive folder to the Import folder.  

The file is now available for viewing on your C drive at C:\Program Files\Medicare Remit 
EasyPrint\Import. 
 

 

Deleting Import files 
If you delete an Import file by mistake, you must re-import the HIPAA 835 file. You cannot 
restore the Import file. 

How to Delete an Import file 
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon. 

  
The Medicare Remit Easy Print Claim List tab opens. 

Hint: 
To archive all the 
claim files on the list, 
place a checkmark in 
the Check All box 
When you check that 
box places a 
checkmark in front of 
all the claims in the 
list. 
 

Pathname for the 
Archive folder 
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2. On the top of the window, click the Delete button. 



Medicare Remit Easy Print Housekeeping for the Import Files 

 
© 2005 ViPS®, a General Dynamics IT Company. All Rights Reserved. 

This document contains GDIT confidential and proprietary information, 
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs. 

214 

The Delete selected import file(s) window opens. 

 
3. Select the file(s) you want to delete by checking the box(es).  

This activates the Delete button. 
4. Click the Delete button. 

Medicare Remit Easy Print deletes the file(s). 

Hint: 
To delete all the claim 
files on the list, place a 
checkmark in the Check 
All box. When you 
check that box 
checkmark is placed in 
front of all the claims in 
the list. 
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Using Keystroke Shortcuts 
You can use a series of keystrokes to complete a number of tasks. 

To Do This… Use This 
Combination… 

Import a HIPAA 835 file Alt + F + I 

View a list of claims Alt + V + L 

View claim detail Alt + V + D 

View totals Alt + V + S 

View the way the data is stored in the file Alt + V + V 

Search the Remittance Advice Alt + V + E    Or 
Alt + S + S 

View the CARC and RARC codes for the Remittance Advice Alt + V + G 

Look up the meaning of a CARC/RARC code Alt + T + C 

Print the Denied Service Lines Report Alt + R + D + P 

Export the Denied Service Lines Report Alt + R + D + E 

Print the Adjusted Service Lines Report Alt +R + A + P 

Export Adjusted Service Lines Report Alt +R + A + E 

Print the Deductible Service Lines Report Alt +R + E + P 

Export the Deductible Service Lines Report Alt +R + E + E 

Print the Entire Remittance Report Alt +R + R + P 

Archive Import files Alt + T + A 

Restore archived Import files Alt + T + R 

Delete Import files Alt + T + D 

With the Claim List Tab Selected:  

Print Claim List Alt + B + P 

Check all claims in the list Alt + B + C 

Uncheck all claims in the list Alt + B + U 

Claim display (single line format)    
    * Claim must be highlighted  

Alt + B + D 

With the Claim Detail Tab Selected:  

Print Claim Detail Alt + B + P 

Zoom In  Alt + B + I 

Zoom Out Alt + B + O 

Reset Zoom Alt + B + R 

Show Glossary ( check box ) Alt + B + S 
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To Do This… Use This 
Combination… 

With the Remit Summary Tab Selected:  

Print Summary Alt + B + P 

Zoom In  Alt + B + I 

Zoom Out Alt + B + O 

Reset Zoom Alt + B + R 

With the Search Tab Selected:  

Print Results Alt + B + P 

Results Claim Detail  Alt + B + C 

With the Glossary Tab Selected:  

Zoom In Alt + B + I 

Zoom Out Alt + B + O 

Reset Zoom Alt + B + R 

Codes Alt + B + C 
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Appendix A: MREP RA/HIPAA 835v5010 Segment Field 
Crosswalk 
This information can help you if you need to troubleshoot the Import file. 

Note:  This appendix represents the fields of an 835v5010 electronic remittance advice. However, MREP can 
also print or display remittances in the 4010A1format. Fields marked with an asterisk (*) below are not 
found on the 4010A1 format and do not appear when printed or displayed. 

  
Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 

Payer (Contractor) Name 1000A N102  N101 = ‘PR’ 
Payer (Contractor) Address 1000A N301 N101 = ‘PR’, ADDR1 
   N302 N101 = ‘PR’, ADDR2 
Payer (Contractor) City 1000A N401 N101 = ‘PR’ 
Payer (Contractor) State 1000A N402 N101 = ‘PR’ 
Payer (Contractor) Zip 1000A N403 N101 = ‘PR’ 
* PAYER’S WEB SITE:  1000A PER04 PER01 = ‘IC’ 
* PAYER BUSINESS 
CONTACT INFORMATION: 

1000A  PER01= ‘CX’ 

* Name  PER02  
* Email Address (up to 50 
positions) 

 PER04 or PER06 PER03 or PER05 = ‘EM’ 
(respectively) 

* Telephone Number 
 

 PER04 and PER06 
PER06 and PER08 

PER03 = ‘TE’ and PER05 = ‘EX’ 
PER05 = ‘TE’ and PER07 = ‘EX’ 

* PAYER TECHNICAL 
CONTACT INFORMATION: 

1000A  PER01= ‘BL’ 

Payee (Provider) Name 1000B N102 N101 = ‘PE’ 
Payee (Provider) Address 1000B N301 

 
N302 

N101 = ‘PE’, ADDR1 
 
N101 = ‘PE’, ADDR2 

Payee (Provider) City 1000B N401 N101 = ‘PE’ 
Payee (Provider) State 1000B N402 N101 = ‘PE’ 
Payee (Provider) Zip 1000B N403 N101 = ‘PE’ 
PROVIDER #  
or  
NPI # 

1000B N104 
or 
REF02 

N101 = ‘PE’ & N103 = ‘XX’ 
 
Payee level REF01 = ‘1C’ 

Date  BPR16  
CHECK/EFT #  TRN02 BPR04 = ‘CHK’ or ‘EFT’ or ‘NON’ 
Assigned claims LX01 = ‘1’, pertains only to 

Medicare 
    
NAME 
(Patient Last Name) 

2100 NM103 NM101 = ‘QC’ 

NAME 
(Patient First Name) 

2100 NM104 NM101 = ‘QC’ / NM102 = ‘1’ 

NAME 
(Patient Middle Name) 

2100 NM105 NM101 = ‘QC’ / NM102 = ‘1’ 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 
HIC  
(Patient ID) 

2100 NM109 NM108 = ‘HN’ 

ACNT  
(Patient Account Number) 

2100 CLP01  

ICN 
(Claim Control Number) 

 CLP07  

ASG  
(Claim Assignment) 

2000  Hard-coded ‘Y’ for Medicare when 
LX01 = ‘1’ 

MOA 
(Claim Level Remark Codes) 

2100 MOA03, MOA04, 
MOA05, MOA06, 
MOA07 

 

REND PROV  
(Rendering Provider) 

2110 REF02  REF01 = HPI or  
REF01 = ‘1C’  

 2100 NM109 or 
REF02  

NM108 = ‘XX’ or 
REF01 = ‘1C’  

 1000B N104 or  
REF02 or 
spaces 

N103 = ‘XX’ or 
REF01 = ‘XX’ 

SERV-DATE 
(From Service Date) 

2110 DTM02 Line level DTM01 = ‘150’ or ‘472’ 
else Claim level DTM01 = ‘232’ 

SERV-DATE 
(To Service Date) 

2110 DTM02 Line level DTM01 = ‘151’ or ‘472’ 
else Claim level DTM01 = ‘233’ 

POS 
(Place of Service) 

2110 REF02 REF01 = ‘LU’ 

PD-NOS 
(Paid Number of Services) 

2110 SVC05  

PD-PROC 
(Procedure code – paid and if 
down-coded then the original 
procedure appears under 
SUB-PROC.) 

2110 SVC01-2 SVC01-1 = ‘HC’ or ‘N4’ 

MODS 
(Procedure Code Modifiers)  

2110 SVC01-3, SVC01-4, 
SVC01-5, SVC01-6 

SVC01-1 = ‘HC’ or ‘N4’ 

BILLED 
(Billed Amount) 

2110 SVC02  

ALLOWED 
(Allowed Amount) 

2110 AMT02 AMT01 = ‘B6’ 

DEDUCT 
(Deductible Amount)  

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘1’ or 
CAS05 = ‘1’ or CAS08 = ‘1’ or 
CAS11 = ‘1’ or CAS14 = ‘1’ or 
CAS17 = ‘1’) 

COINS 
(Coinsurance Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘2’ or 
CAS05 = ‘2’ or CAS08 = ‘2’ or 
CAS11 = ‘2’ or CAS14 = ‘2’ or 
CAS17 = ‘2’) 

GRP/CARC 
(Group/Claim Adjustment 
Reason Code) 

 

2110 CAS01-CAS02, CAS05, 
CAS08, CAS11, CAS14, 
CAS17 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)); hard-
code dash between group code 
and reason code 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 
CARC-AMT 
(Claim Adjustment Reason 
Code Amount) 
 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)) 

ADJ-QTY   
(Adjustment Quantity) 

2110 CAS04 or CAS07 or 
CAS10 or CAS13 or 
CAS16 or CAS19 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)) 

PROV-PD 
(Provider Paid Amount) 

2110 SVC03  

SUB-NOS : 
(Submitted Number of 
Services) 

2110 SVC07 If paid units of service (SVC05) do 
not equal submitted units of 
service 

SUB-PROC 
(Submitted Procedure Code) 

2110 SVC06-2, SVC06-3, 
SVC06-4, SVC06-5, 
SVC06-6 

 

RARC 
(Line Level Remark Codes) 

2110 LQ02 LQ01 = ‘HE’ 

* CNTL #: 
(Line Item Control Number) 
 

2110 REF02 REF01 = ‘6R’ 

* HCPI: 
(HealthCare Policy 
Information) 
 

2110 REF02 REF01 = ‘0K’ (zero K) 

PT RESP 
(Patient Responsibility) 

2100 CLP05  

CLAIM TOTALS 
(Billed Amount) 

2100 CLP03  

CLAIM TOTALS 
(Allowed Amount) 

  Sum of all lines AMT02, when 
AMT01 = ‘B6’ 

CLAIM TOTALS 
(Deductible Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘1’ 

CLAIM TOTALS 
(Coinsurance Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘2’ 

CLAIM TOTALS  
(Reason Code Amounts) 

  Sum of all lines CAS monetary 
amounts, except those associated 
with adjustment reason codes ‘1’ 
and ‘2’ (Group code PR) 

CLAIM TOTALS 
(Provider Paid Amount) 

2100 CLP04  

ADJ TO TOTALS: PREV PD 
(Adjustment to Totals: 
Previous Paid Amount) 

  Not available 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 
ADJ TO TOTALS: INTEREST 
(Adjustment to Totals: Interest 
Amount) 

2100 AMT02 Claim level AMT01 = ‘I’ 

ADJ TO TOTALS: LATE 
FILING CHARGE 
(Adjustment to Totals: Late 
Filing Charge) 
 

2110  Sum of all line level AMT02, when 
AMT01 = ‘KH’ 

NET   Sum of all the line level provider 
paid amts plus adj to totals: 
interest minus adj to totals: late 
filing charge 

CLAIM INFORMATION 
FORWARDED TO: 

2100  NM101 = ‘TT’  
 

(Crossover Carrier Name)  NM103  NM102 = ‘2’ 
* (Crossover Carrier Identifier)  NM109 NM108 = ‘PI’ or ‘XV’ 
* CORRECTED PRIORITY 
PAYER INFO: 

2100  NM101 = ‘PR’ 

* (Corrected Priority Payer 
Name) 

 NM103  NM102 = ‘2’ 

* (Corrected Priority Payer 
Identification Number) 

 NM109 NM108 = ‘PI’ or ‘XV’ 

TOTALS: # OF CLAIMS   Number of CLP segments within a 
LX 

TOTALS: BILLED AMT 
(Total – Billed Amount) 

  Sum of CLP03 

TOTALS: ALLOWED AMT 
(Total – Allowed Amount) 

  Sum of AMT02 when AMT01 = 
‘B6’ 

TOTALS: DEDUCT AMT 
(Total – Deductible Amount) 

  Sum of CAS monetary amts, when 
CAS01 = ‘PR’ and the 
corresponding adjustment reason 
code equals ‘1’ 

TOTALS: COINS AMT 
(Total – Coinsurance Amount) 

  Sum of CAS monetary amts, when 
CAS01 = ‘PR’ and the 
corresponding adjustment reason 
code equals ‘2’ 

TOTAL: CARC-AMT 
(Total – Claim Adjustment 
Reason Code Amount) 

  Sum of CAS monetary amounts, 
excepting those associated with 
adjustment reason codes ‘1’ and 
‘2’ 

TOTALS: PROV-PD AMT 
(Total – Provider Paid 
Amount) 

  Sum of CLP04 

TOTALS: PROV ADJ AMT 
(Total – Provider Adjustment 
Amount) 

  Sum of AMT02 when AMT01 = 
‘B6’ and ‘KH’ 
(The sum of the details (amount) in 
the PROVIDER ADJ DETAILS 
section.)  

CHECK AMT 

(Check Amount) 

 BPR02  

Provider Adjustment Details 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 
PLB REASON CODE  PLB03-1, PLB05-1,  

PLB07-1, PLB09-1, 
PLB11-1, PLB13-1 

 

FCN/OTHER IDENTIFIER  Positions 1–50 of 
PLB03-2, PLB05-2, 
PLB07-2, PLB09-2, 
PLB11-2, PLB13-2 

 

AMOUNT  PLB04, PLB06, PLB08, 
PLB10, PLB12, PLB14 

 

Summary of non-assigned claims LX01 = ‘0’, pertains only to 
Medicare 

NAME 
(Patient Last Name) 

2100 NM103 NM101 = ‘QC’ 

NAME 
(Patient First Name) 

2100 NM104 NM101 = ‘QC’ / NM102 = ‘1’ 

NAME 
(Patient Middle Name) 

2100 NM105 NM101 = ‘QC’ / NM102 = ‘1’ 

HIC 
(Patient ID) 

2100 NM109 NM108 = ‘HN’ 

ACNT  
(Patient Account Number) 

2100 CLP01  

ICN 
(Claim Control Number) 

 CLP07  

ASG  
(Claim Assignment) 

2000  Hard-coded ‘N’ for Medicare when 
LX01 = ‘0’ 

MOA 
(Claim Level Remark Codes) 

2100 MOA03, MOA04, 
MOA05, MOA06, 
MOA07 

 

REND PROV 
(Rendering Provider) 

2110 REF02 REF01 = HPI or  
REF01 = ‘1C’ 

 2100 NM109 or 
REF02  

NM108 = ‘XX’ or 
REF01 = ‘1C’  

 1000B N104 or  
REF02 or 
spaces 

N103 = ‘XX’ or 
REF01 = ‘XX’ 

SERV-DATE 
(From Service Date) 

2110 DTM02 Line level DTM01 = ‘150’ or ‘472’ 
else Claim level DTM01 = ‘232’ 

SERV-DATE 
(To Service Date) 

2110 DTM02 Line level DTM01 = ‘151’ or ‘472’ 
else Claim level DTM01 = ‘233’ 

POS 
(Place of Service) 

2110 REF02 REF01 = ‘LU’ 

PD-NOS 
(Paid Number of Services) 

2110 SVC05  

PD-PROC 
(Procedure code – paid and if 
down-coded then the original 
procedure appears.) 

2110 SVC01-2 SVC01-1 = ‘HC’ or ‘N4’ 

MODS 
(Procedure code modifiers) 

2110 SVC01-3, SVC01-4, 
SVC01-5, SVC01-6 

SVC01-1 = ‘HC’ or ‘N4’ 

BILLED 
(Billed Amount) 

2110 SVC02  
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 
ALLOWED 
(Allowed Amount) 

2110 AMT02 AMT01 = ‘B6’ 

DEDUCT 
(Deductible Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘1’ or 
CAS05 = ‘1’ or CAS08 = ‘1’ or 
CAS11 = ‘1’ or CAS14 = ‘1’ or 
CAS17 = ‘1’) 

COINS 
(Coinsurance Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

CAS01 = ‘PR’ & (CAS02 = ‘2’ or 
CAS05 = ‘2’ or CAS08 = ‘2’ or 
CAS11 = ‘2’ or CAS14 = ‘2’ or 
CAS17 = ‘2’) 

GRP/CARC 
(Group/ Claim Adjustment 
Reason Code) 

2110 CAS01-CAS02, CAS05, 
CAS08, CAS11, CAS14, 
CAS17 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)); hard-
code dash between group code 
and reason code 

CARC-AMT 
(Claim Adjustment Reason 
Code Amount) 

2110 CAS03 or CAS06 or 
CAS09 or CAS12 or 
CAS15 or CAS18 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’)) 

ADJ-QTY 
(Adjusted Quantity) 

2110 CAS04 or CAS07 or 
CAS10 or CAS13 or 
CAS16 or CAS19 

Do not print CAS01 = ‘PR’ and 
((CAS02 = ‘1’ or ‘2’) or (CAS05 = 
‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2’) or 
(CAS11 = ‘1’ or ‘2’) or (CAS14 = ‘1’ 
or ‘2’) or (CAS17 ‘1’ or ‘2’) 

PROV-PD 
(Provider Paid Amount) 

2110 SVC03  

SUB-NOS  
(Submitted Number of 
Services) 

2110 SVC07 If paid units of service (SVC05) do 
not equal submitted units of 
service 

SUB-PROC 
(Submitted procedure code) 

2110 SVC06-2, SVC06-3, 
SVC06-4, SVC06-5, 
SVC06-6 

 

RARC 
(Line Level Remark Codes) 

2110 LQ02 LQ01 = ‘HE’ 

PT RESP 
(Patient Responsibility) 

2100 CLP05  

CLAIM TOTAL 
(Billed Amount) 

2100 CLP03  

CLAIM TOTAL 
(Allowed Amount) 

  Sum of all lines AMT02, when 
AMT01 = B6. 

CLAIM TOTAL 
(Deductible Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘1’ 

CLAIM TOTAL 
(Coinsurance Amount) 

  Sum of all lines CAS monetary 
amounts, when CAS01 = ‘PR’ and 
the corresponding adjustment 
reason code equals ‘2’ 
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments 
CLAIM TOTAL  
(Reason Code Amounts) 

  Sum of all lines CAS monetary 
amounts, excepting those 
associated with adjustment reason 
codes ‘1’ and ‘2’ 

CLAIM TOTAL 
(Provider Paid Amount) 

2100 CLP04  

ADJ TO TOTALS: PREV PD 
(Adjustment to Totals: 
Previous Paid Amount) 
 

  Not available 

ADJ TO TOTALS: INTEREST 
(Adjustment to Totals: Interest 
Amount) 

2100 AMT02 Claim level AMT01 = ‘I’ 

ADJ TO TOTALS: LATE 
FILING CHARGE 
(Adjustment to Totals: Late 
Filing Charge) 
 

2110  Sum of all line level AMT02, when 
AMT01 = ‘KH’ 

NET   Sum of all the line level provider 
paid amts plus adj to totals: 
interest minus adj to totals: late 
filing charge 

CLAIM INFORMATION 
FORWARDED TO: 
 

2100  NM101 = ‘TT’  

* (Crossover Carrier Name) 
 

 NM103  NM102 = ‘2’ 

* (Crossover Carrier Identifier) 
 

 NM109 NM108 = ‘PI’ or ‘XV’ 

* CORRECTED PRIORITY 
PAYER INFO : 
 

2100  NM101 = ‘PR’ 

* (Corrected Priority Payer 
Name) 
 

 NM103  NM102 = ‘2’ 

* (Corrected Priority Payer 
Identification Number) 
 

 NM109 NM108 = ‘PI’ or ‘XV’ 

* OTHER CLAIM REL 
IDENTIFICATION  
 

2100 REF02 when 
REF01=’1L’, ‘1W’, ’28’,  
‘6P’, ‘9A’, ‘9C’,  
‘BB’, ‘CE’, ‘EA’, ‘F8’, 
‘G1’, ‘G3’, ‘IG’ OR ‘SY’ 

 

GLOSSARY  MOA03, MOA04, 
MOA05, MOA06, 
MOA07, CAS01, 
CAS02, CAS05, CAS08, 
CAS11, CAS14, CAS17 

If there are duplicates, only print 
once 
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Appendix B:  Abbreviation and Acronym Glossary  
 
The following two column table provides the abbreviations or acronym values in the first 
column, and the second column contains the descriptions. 
 

Abbreviation or Acronym 
Value 

Description 

ACNT Account 
ADJ Adjustment 
ADJ-QTY Adjustment Quantity 
Adjst Adjustment 
AMT Amount 
ASG Assignment of claim 
Bene Beneficiary 
CARC Claim Adjustment Reason Code 
CARC-AMT Claim Adjustment Reason Code Amount 
CNTL# Control Number 
COB Coordination of Benefits 
COIN Coinsurance 
Coins Coinsurance 
Deduct Deductible 
DMERC Durable Medical Equipment Resource Center 
ERA Electronic Remittance Advice 
EFT Electronic Funds Transfer 
GRP/CARC Group and Claim Adjustment Reason Codes 
HCPCS Health Care Procedure Codes 
HCPI Health Care Policy Information 
HIC Health Insurance Claim Number 
HICN  Health Insurance Claim Number 
HIPAA Health Insurance Portability and Accountability Act 
ID Identifier 
ICN Internal Control Number 
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Abbreviation or Acronym 
Value 

Description 

MOA Medicare Outpatient Adjudication 
MODS Modifiers 
MREP Medicare Remit Easy Print 
MSP Medicare Secondary Payer 
NDC National Drug Code 
NPI National Provider Identifier 
NOS Number of Services 
Orig Original 
PD-NOS Number of Services – Paid  
PD-PROC Procedure Code – Paid 
PHI Personal Health Information 
PLB Provider Level Balancing 
POS Place of Service 
PREV PD Previous Paid 
PROC Procedure Code  
PROV Provider 
PROV-PD Provider Paid 
PT RESP Patient Responsibility 
RARC Remittance Advice Remark Code 
Remit Remittance Advice 
REND-PROV Rendering Provider 
SERV-DATE Service Dates 
SPR Standard Paper Remittance advice 
SUB-NOS Submitted Number of Services 
SUB-PROC Submitted HCPCS Procedure Code 
Zip ZIP Code 
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